Quiz 1

	Multiple Choice
	Question 1:


(1 Point) 
	A user works with and communicates through a(n):


a. User interface. 
b. Office button system. 
c. Status bar. 
d. Template. 
	

	 
	
	



	Question 2:


(1 Point) 
	Which folder was automatically created through Windows XP?


a. My Documents 
b. My Files 
c. My Stuff 
d. My Work 
	

	 
	
	



	Question 3:


(1 Point) 
	What does an ellipsis (…) indicate following a menu selection?



a. It indicates that the command is currently off. 
b. It is not an option currently available. 
c. It indicates that an option must double-click on it for a command to be executed. 
d. It indicates that additional information is required to execute the command. 
	

	 
	
	



	Question 4:


(1 Point) 
	Which special window allows a user to change settings or make selections?


a. List box 
b. Text window 
c. Dialog box 
d. Text box 
	

	 
	
	



	Question 5:


(1 Point) 
	Where can deleted files and/or folders be retrieved from?

a. Recycle Bin 
b. My Documents 
c. Notepad 
d. My Computer 
	

	 
	
	



	Question 6:


(1 Point) 
	A Limited user account allows the user to do all of the following EXCEPT: 


a. Installing programs. 
b. Customizing the desktop. 
c. Changing the password. 
d. Working with files that the user has created. 
	

	 
	
	



	Question 7:


(1 Point) 
	What is the purpose of using the Help and Support Center in Microsoft Office 2007?


a. It enables the user to give an instruction by typing in a box. 
b. It is a special window that requests input or presents information. 
c. It is a miniature display of a folder or page. 
d. It provides assistance on Windows topics. 
	

	 
	
	



	Question 8:


(1 Point) 
	Where can a user handle the following: system settings, printer settings and mouse settings?


a. Settings feature 
b. Control Panel 
c. Control Settings 
d. Desktop 
	

	 
	
	



	Question 9:


(1 Point) 
	Which button does a user click on to locate a file on the hard disk to use as a background?

a. Find button 
b. Locate button 
c. Browse button 
d. Open button 
	

	 
	
	



	Question 10:


(1 Point) 
	Which Windows feature has the quickest assistance with Windows topics?

a. Index 
b. Table of Contents 
c. Online 
d. Remote help 
	

	 
	
	



	Question 11:


(1 Point) 
	How does a user access a submenu?


a. Right-click the menu item 
b. Double-click the menu item 
c. Point to it with the mouse 
d. Click the menu item 
	

	 
	
	



	Question 12:


(1 Point) 
	Why is it a necessity to backed up files on a different media drive?


a. All files are stored in the Recycle Bin. 
b. Any file can be recovered from the internet. 
c. It is not necessary since files can be saved on the hard drive of the computer. 
d. Any file can be recovered by the user should the hard drive die. 
	

	 
	
	



	Question 13:


(1 Point) 
	What is the extension file of Word 2007?


a. .dot 
b. .dox 
c. .doc 
d. .docx 
	

	 
	
	



	Question 14:


(1 Point) 
	What is in the bottom-left corner of every shortcut?


a. A plus sign 
b. An arrow 
c. A Windows logo 
d. An open or closed folder icon 
	

	 
	
	



	Question 15:


(1 Point) 
	Which button can be found on the Standard buttons toolbar that allows the user to view all storage devices on a system when clicking on the My Computer folder?


a. Folders 
b. Storage 
c. Drives 
d. Open 
	

	 
	
	



	Question 16:


(1 Point) 
	The Office menu contains all of the following features EXCEPT: 
a. Edit. 
b. New. 
c. Print. 
d. Open. 
	

	 
	
	



	Question 17:


(1 Point) 
	What is an option when the Save As command has been selected?


a. This option allows the file to be copied with the same name in the same location. 
b. This option is stored in the temporary memory of the computer. 
c. This option allows the document to be automatically saved using the original filename. 
d. This option allows the file to be saved in a new location. 
	

	 
	
	



	Question 18:


(1 Point) 
	Where is a working file stored?


a. It is saved on the internet. 
b. It is saved on the hard drive of the computer. 
c. It is saved in RAM of the computer. 
d. It is saved in ROM of the computer. 
	

	 
	
	



	Question 19:


(1 Point) 
	Where can the Recent Documents List be found?

a. In the Office button when it is clicked. 
b. In the Home tab. 
c. In the Open dialog box. 
d. In the drop-down arrow is selected next to the Look-in box. 
	

	 
	
	



	Question 20:


(1 Point) 
	Which core command is not found in the Home tab.


a. Copy 
b. File 
c. Format Painter 
d. Cut 
	

	 
	
	



	Question 21:


(1 Point) 
	To resize a window, point with the mouse arrow to a window border; the mouse arrow will change to a:


a. Four-headed arrow. 
b. Double arrow. 
c. plus sign. 
d. Hand. 
	

	 
	
	



	Question 22:


(1 Point) 
	By default, where is the Recycle Bin located?


a. Desktop 
b. My Documents 
c. Shortcut menu 
d. Start menu 
	

	 
	
	



	Question 23:


(1 Point) 
	What appears next to a folder when it contains subfolders that are not in view?


a. A minus sign (-) 
b. A plus sign (+) 
c. An asterisk (*) 
d. A check mark (v) 
	

	 
	
	



	Question 24:


(1 Point) 
	When a user starts any program in Microsoft Office, what is the default document called?


a. Document1 
b. Word1 
c. Word1.docx 
d. File1 
	

	 
	
	



	Question 25:


(1 Point) 
	Where can the Open command be found in Microsoft Office 2007?


a. From the Open dialog box. 
b. From the Open menu. 
c. From the Office menu. 
d. By clicking Alt+O. 
	

	 
	
	



	Question 26:


(1 Point) 
	How can a user view all of the programs available on the computer?


a. On the Taskbar. 
b. Click the All Programs icon on the desktop. 
c. Click the Start button, then point to All Programs. 
d. From the icons on the desktop. 
	

	 
	
	



	Question 27:


(1 Point) 
	Which toolbar button found in the Help and Support Center shows all pages that were visited in the help session.



a. Favourites 
b. History 
c. Previous 
d. Back 
	

	 
	
	



	Question 28:


(1 Point) 
	Which Windows command allows the user to change the background and the screen saver?

a. Change Desktop 
b. Desktop Properties 
c. Display Features 
d. Display Properties 
	

	 
	
	



	Question 29:


(1 Point) 
	Where is the Undo button located?


a. On the Office button. 
b. On the Quick Access Toolbar. 
c. On the Shortcut menu. 
d. On the Home tab. 
	

	 
	
	



	Question 30:


(1 Point) 
	What is located at the bottom of the screen that allows users to switch among various open windows?


a. Shortcut menu 
b. Desktop 
c. Taskbar 
d. Quick Launch toolbar 
	

	 
	
	




	True and False 
	Question 1:


(1 Points) 
	If a file has been sent to the printer, it cannot be deleted.




· True 
· False 
	



	Question 2:


(1 Points) 
	Help can be accessed from within a dialog box.
  




· True 
· False 
	



	Question 3:


(1 Points) 
	An Open Read-Only file can be edited; an Opened file cannot.
 



· True 
· False 
	



	Question 4:


(1 Points) 
	A folder can easily be renamed by right-clicking on the folder and selecting Rename.  



· True 
· False 
	



	Question 5:


(1 Points) 
	Bolding, italicizing, and underlining are all formatting options. 



· True 
· False 
	



	Question 6:


(1 Points) 
	It is recommended to preview a document before printing it.
 
   



· True 
· False 
	



	Question 7:


(1 Points) 
	The default shortcuts and the folders that is added to the My Places Bar can be deleted.    




· True 
· False 
	



	Question 8:


(1 Points) 
	The Windows Desktop Search or the Search Companion locates misplaced files. 




· True 
· False 
	



	Question 9:


(1 Points) 
	The Quick Launch toolbar is located in the bottom right corner of the screen.




· True 
· False 
	



	Question 10:


(1 Points) 
	A screen saver is a moving image displayed on the screen.




· True 
· False 






Quiz 2

		Question 1:


(1 Point) 
	Which of the following is included in the Title bar?


a. The file name and the size of the file. 
b. The application and the file name. 
c. The file name. 
d. The application, the file name, and the size of the file. 
	

	 
	
	



	Question 2:


(1 Point) 
	Which group is the Page Number command found in?

a. Header and Footer 
b. Paragraph 
c. Text 
d. Page Setup 
	

	 
	
	



	Question 3:


(1 Point) 
	Which keyboard shortcut turns the highlighting feature off?


a. Ctrl 
b. Ctrl+O 
c. F6 
d. Esc 
	

	 
	
	



	Question 4:


(1 Point) 
	Which dialog box is the Character Spacing tab located in?



a. Text 
b. Spacing 
c. Format 
d. Font 
	

	 
	
	



	Question 5:


(1 Point) 
	Which option keeps all lines of a paragraph together on the same page?

a. Keep lines together 
b. Window 
c. Paragraph Spacing 
d. Keep with next 
	

	 
	
	



	Question 6:


(1 Point) 
	Which option should a user select to stretch a title across the page?


a. Horizontal Alignment 
b. Scale 
c. Proportional 
d. Expanded 
	

	 
	
	



	Question 7:


(1 Point) 
	Which command removes the page numbering in a document?


a. Delete Page Numbers 
b. Remove Numbering 
c. Delete Page Features 
d. Remove Page Numbers 
	

	 
	
	



	Question 8:


(1 Point) 
	Which typeface contains a thin line or extension at the top and bottom of characters?


a. Serif 
b. Monospaced 
c. Sans Serif 
d. Kerning 
	

	 
	
	



	Question 9:


(1 Point) 
	What type style is found in Word 2007?


a. Typography 
b. Sans Serif typeface 
c. Italics 
d. Proportional typeface 
	

	 
	
	



	Question 10:


(1 Point) 
	How is an insertion point moved in a document?


a. Only the keyboard. 
b. The mouse and the keyboard. 
c. The scroll bar and the mouse. 
d. The scroll bar, the mouse and the keyboard. 
	

	 
	
	



	Question 11:


(1 Point) 
	Which tab is the Cover Page feature found in?

a. Page Orientation 
b. Formatting 
c. Insert 
d. Page Layout 
	

	 
	
	



	Question 12:


(1 Point) 
	What happens if a section break is deleted?


a. A new section break is automatically created. 
b. The text above the deleted break takes on the formatting of the following section. 
c. A section break can not be deleted. 
d. The formatting for that section remains even though the section break has been deleted. 
	

	 
	
	



	Question 13:


(1 Point) 
	What happens to the Mini toolbar when the mouse pointer moves near it?


a. It disappears. 
b. It becomes darker. 
c. A screen tip pops up. 
d. Nothing until the user right clicks on it. 
	

	 
	
	



	Question 14:


(1 Point) 
	Where is the Status bar located?


a. On the left of the document window. 
b. On the right of the document window. 
c. At the bottom of the document window. 
d. At the top of the document window. 
	

	 
	
	



	Question 15:


(1 Point) 
	Where are the tabs in Word 2007 displayed?


a. On the Reference page. 
b. Other Page Setup group. 
c. On the Formatting toolbar. 
d. On the Ribbon. 
	

	 
	
	



	Question 16:


(1 Point) 
	Which of the following can NOT be created in a word processor?

a. Web page 
b. Report 
c. Database 
d. Brochure 
	

	 
	
	



	Question 17:


(1 Point) 
	Which keyboard shortcut is a quick way to bring up the dialog box to jump to a specific page number?


a. Ctrl+G 
b. Alt+G 
c. Ctrl+Shift+G 
d. Ctrl+F 
	

	 
	
	



	Question 18:


(1 Point) 
	Which command allows the user to divide a cell into different cells?


a. Divide Cells 
b. Split Cells 
c. Separate Cells 
d. Unmerge Cells 
	

	 
	
	



	Question 19:


(1 Point) 
	What indicates that there may be a contextual error in the document?


a. A red underline. 
b. A blue wavy underline. 
c. A green box. 
d. The word is highlighted in red. 
	

	 
	
	



	Question 20:


(1 Point) 
	What must be selected to display formatting properties in the Reveal Formatting task pane? 
a. Check box 
b. Minus sign 
c. Radio button 
d. Plus sign 
	

	 
	
	



	Question 21:


(1 Point) 
	Which tab can add a header and footer to a document?


a. Page Layout 
b. Page Orientation 
c. Insert 
d. Formatting 
	

	 
	
	



	Question 22:


(1 Point) 
	How does a user apply an existing style to a paragraph?


a. The cursor must be located before the first character in the paragraph. 
b. The cursor must be located anywhere within the paragraph. 
c. The cursor must be at the end of the paragraph. 
d. The Paragraph must first be selected. 
	

	 
	
	



	Question 23:


(1 Point) 
	What must be selected from the Page Setup Group on the Page Layout tab to determine where a section begins and ends?


a. Reveal 
b. Section 
c. Breaks 
d. Page Break 
	

	 
	
	



	Question 24:


(1 Point) 
	What must a user insert to force a new page?


a. Hard return 
b. Soft page break 
c. Hard line break 
d. Hard page break 
	

	 
	
	



	Question 25:


(1 Point) 
	Which of the following is NOT implemented at the section level?


a. Page numbering 
b. Line spacing 
c. Margins 
d. Columns 
	

	 
	
	



	Question 26:


(1 Point) 
	Which group on the Home tab is the Text Highlight Colour command is located in?


a. Font 
b. Insert 
c. Paragraph 
d. Styles 
	

	 
	
	



	Question 27:


(1 Point) 
	What must a user select to change to a different tab? 
a. Roman numeral 
b. Number 
c. Name 
d. Color 
	

	 
	
	



	Question 28:


(1 Point) 
	Which tab is NOT found in the Find and Replace dialog box?


a. Replace 
b. Locate 
c. Find 
d. Go To 
	

	 
	
	



	Question 29:


(1 Point) 
	Which view closely resembles the printed document?


a. Draft view 
b. Print Layout view 
c. Full Screen Reading view 
d. Outline view 
	

	 
	
	



	Question 30:


(1 Point) 
	What does a table of contents lists?


a. The page number where each heading begins. 
b. All of the pages in the heading area. 
c. Every page where the words in each heading are listed. 
d. All the headings in alphabetical order. 
	

	 
	
	




	True and False
	Question 1:


(1 Points) 
	An advantage to using a footer is that a user can type the information once and it shows up on every page.  




· True 
· False 
	



	Question 2:


(1 Points) 
	Table Borders and Shading commands are available on the Format tab. 




· True 
· False 
	



	Question 3:


(1 Points) 
	All ClipArt images are a predetermined size when inserted into a document; the image size must be adjusted. 




· True 
· False 
	



	Question 4:


(1 Points) 
	The Find feature locates a specific text one time only. 




· True 
· False 
	



	Question 5:


(1 Points) 
	Page numbers can be placed at the top or bottom of the page and aligned left, right  or center.
  


· True 
· False 
	



	Question 6:


(1 Points) 
	A section break is a marker that divides a document into sections, thereby allowing different formatting in each section. 




· True 
· False 
	



	Question 7:


(1 Points) 
	A copyright agreement describes how images can legally be used. 




· True 
· False 
	



	Question 8:


(1 Points) 
	To access Quick Parts gallery the user must access the Insert tab.
 




· True 
· False 
	



	Question 9:


(1 Points) 
	QAT stands for Quick Automatic Toolbar.




· True 
· False 
	



	Question 10:


(1 Points) 
	Shading a cell affects the line around the cell.



· True 
· False 








Quiz 3

		Question 1:


(1 Point) 
	Which tab can the Comment command be found?


a. Home 
b. Documentation 
c. Comment 
d. Review 
	

	 
	
	



	Question 2:


(1 Point) 
	Which type of data includes letters, numbers, symbols and spaces?

a. Text 
b. Symbol 
c. Constant 
d. Macro 
	

	 
	
	



	Question 3:


(1 Point) 
	Which of the following is the computerized equivalent of a ledger?

a. Document 
b. Database 
c. Spreadsheet 
d. Brochure 
	

	 
	
	



	Question 4:


(1 Point) 
	Which funtion counts the number of cells in a range that are not blank?

a. ANALYZE 
b. COUNTA 
c. COUNT 
d. MAX 
	

	 
	
	



	Question 5:


(1 Point) 
	What  is a rectangular group of cells?

a. Style 
b. Range 
c. Location 
d. Macro 
	

	 
	
	



	Question 6:


(1 Point) 
	Which of the following is known as the lowest numeric value for a category or series in a lookup table to produce a corresponding result for a lookup function?

a. Breakpoint. 
b. Final point 
c. Start point 
d. Results point 
	

	 
	
	



	Question 7:


(1 Point) 
	What cell references in formulas do when the Insert and Delete commands are used to an existing worksheet?



a. Automatically adjust. 
b. Become absolute cell references. 
c. Disappear. 
d. Display an error. 
	

	 
	
	



	Question 8:


(1 Point) 
	What is an example of a formula?


a. =A6 + Z35 
b. A52 + 43 
c. =55H ~ 3 
d. 4G * G1 
	

	 
	
	



	Question 9:


(1 Point) 
	Which Page orientation option prints horizontally across the page and is used when the worksheet is too wide to fit on a portrait page?


a. Portrait 
b. Thumbnail 
c. Landscape 
d. Life size 
	

	 
	
	



	Question 10:


(1 Point) 
	What button is clicked to select all elements of the worksheet?

a. Active cell 
b. Task Bar 
c. Name Box 
d. Select All Button 
	

	 
	
	



	Question 11:


(1 Point) 
	By default, how many sheet tabs does a workbook contain?


a. 4 
b. 2 
c. 1 
d. 3 
	

	 
	
	



	Question 12:


(1 Point) 
	When comparing the content cells of a specific text, what must it be enclosed by?


a. Single quote marks 
b. Parentheses 
c. Quotation marks 
d. Brackets 
	

	 
	
	



	Question 13:


(1 Point) 
	Which function calculates the payment purchasing on a loan?

a. TODAY 
b. IF 
c. PMT 
d. MIN 
	

	 
	
	



	Question 14:


(1 Point) 
	What is a small black square found in the bottom right corner of an selected cell?


a. Insertion point 
b. Pointer 
c. Sizing handle 
d. Fill handle 
	

	 
	
	



	Question 15:


(1 Point) 
	Which Excel operation enables the user to copy the content of a cell or a range of cells by dragging the fill handle over an adjacent cell or range of cells?

a. Paste Special 
b. AutoFormat 
c. AutoFill 
d. Copy 
	

	 
	
	



	Question 16:


(1 Point) 
	Which Excel Window component is made of tabs, groups and commands?

a. Reference Page 
b. Office Menu 
c. Task bar 
d. Ribbon 
	

	 
	
	



	Question 17:


(1 Point) 
	What begins with an equal (=) sign and contains mathematical operators?


a. Date 
b. Textual phrase 
c. Formula 
d. Macro 
	

	 
	
	



	Question 18:


(1 Point) 
	Where can a user enter or edit cell contents?

a. GoTo Dialog box 
b. Task Bar 
c. Name Box 
d. Formula Bar 
	

	 
	
	



	Question 19:


(1 Point) 
	Which Excel Window component indicates the location or name for the active cell? 
a. Formula Bar 
b. Worksheet tab 
c. Name Box 
d. Status Bar 
	

	 
	
	



	Question 20:


(1 Point) 
	What chart option identifies the format or colour of each data series?

a. Diagram 
b. Legend 
c. Note 
d. Pop-up comment box 
	

	 
	
	



	Question 21:


(1 Point) 
	What cell reference stays the same no matter where a formula is copied?


a. Relative 
b. Abstract 
c. Mixed 
d. Absolute 
	

	 
	
	



	Question 22:


(1 Point) 
	What is designated by a column letter and a row number? 
a. Cell name 
b. Cell reference 
c. Row listing 
d. Column designation 
	

	 
	
	



	Question 23:


(1 Point) 
	Which feature automatically adjust the height and width of cells?

a. AutoFit 
b. QuickFormat 
c. Resize 
d. Align 
	

	 
	
	



	Question 24:


(1 Point) 
	What action allows the user to increase or decrease the width of a column?


a. Right click 
b. Point to 
c. Double click 
d. Single click 
	

	 
	
	



	Question 25:


(1 Point) 
	Which of the following can a Sheet Tab do?


a. Rearrange 
b. Restrain 
c. Invert 
d. Rotate 
	

	 
	
	



	Question 26:


(1 Point) 
	What is an option for enhancing tab colors?


a. Icons 
b. Function Colors 
c. Abstract Colors 
d. Theme Colors 
	

	 
	
	



	Question 27:


(1 Point) 
	Which function determines the highest value of all cells in a list of arguments? 



a. AutoSum 
b. CALCULATE 
c. AVERAGE 
d. MAX 
	

	 
	
	



	Question 28:


(1 Point) 
	Which function looks up an answer from a vertical table of possible answers.


a. SEARCH 
b. HLOOKUP 
c. FIND 
d. VLOOKUP 
	

	 
	
	



	Question 29:


(1 Point) 
	Which argument is part of the PMT function?

a. The number of periods. 
b. The future value of the loan. 
c. The square footage of the home that is being purchased. 
d. The payment amount. 
	

	 
	
	



	Question 30:


(1 Point) 
	What represents a page break?

a. Black solid line 
b. Yellow Stars 
c. Blue dashes 
d. Red dashes 
	

	 
	
	




	True and False
	Question 1:


(1 Points) 
	Data must be entered as values to be used in calculations. 




· True 
· False 
	



	Question 2:


(1 Points) 
	AVERAGE, MIN and MAX functions are considered logical functions. 


· True 
· False 
	



	Question 3:


(1 Points) 
	The Office Menu contains commands to Share and Print.




· True 
· False 
	



	Question 4:


(1 Points) 
	Calculations in Excel are NOT affected by mathematical precedence.
 



· True 
· False 
	



	Question 5:


(1 Points) 
	The VLOOKUP function analyzes a value and looks up this value in a horizontal table to return a result. 


· True 
· False 
	



	Question 6:


(1 Points) 
	It is not possible to print an embedded chart without its associated data.



· True 
· False 
	



	Question 7:


(1 Points) 
	Charts that are embedded are part of a compound document. 



· True 
· False 
	



	Question 8:


(1 Points) 
	The order that mathematical operations are performed affect the results of a formula. 


· True 
· False 
	



	Question 9:


(1 Points) 
	Double-clicking a cell with text enables the user to edit the information directly in the cell.
  


· True 
· False 
	



	Question 10:


(1 Points) 
	A user typing numbers into cell C14 is considered the active cell.
 



· True 
· False 







Quiz 4

		Question 1:


(1 Point) 
	What picture tool refers to the brightness or darkness of a picture?


a. Cropping 
b. Flipping 
c. Brightness 
d. Rotating 
	

	 
	
	



	Question 2:


(1 Point) 
	What Colour is the rotation handle on an object?


a. Blue 
b. Yellow 
c. Green 
d. Black 
	

	 
	
	



	Question 3:


(1 Point) 
	Why use slide layouts in PowerPoint?


a. A set of design elements that gives the slide show a unified professional appearance. 
b. It sets a professional tone of the presentation. 
c. It determines the position of objects containing content on the slide. 
d. The remaining slides contain the body of information 
	

	 
	
	



	Question 4:


(1 Point) 
	What key should be press to temporarily override the snap-to feature?


a. Shift 
b. F1 
c. Alt 
d. Ctrl 
	

	 
	
	



	Question 5:


(1 Point) 
	Objects can be animated by applying:


a. Transition 
b. Inserting Clip Art 
c. Animation Scheme 
d. Annotation 
	

	 
	
	



	Question 6:


(1 Point) 
	Why can a ClipArt image not be ungrouped?


a. It is too large for the slide. 
b. It is a mirror-image of the original image. 
c. It has reduced its size by removing unwanted portions of an image. 
d. It is not a vector format. 
	

	 
	
	



	Question 7:


(1 Point) 
	To remove unwanted portions of an image, the user must do the following:


a. Flipping 
b. Cropping 
c. Grouping 
d. Ungrouping 
	

	 
	
	



	Question 8:


(1 Point) 
	What Video File format supported by PowerPoint 2007?


a. Joint Photographic Experts Group 
b. Windows Media File 
c. Adobe Acrobat 
d. Excel 
	

	 
	
	



	Question 9:


(1 Point) 
	Which view is specifically created to enter and edit large amounts of text that the speaker can refer to when speaking?


a. Slider Sorter View 
b. Note page View 
c. Slide Show View 
d. Normal View 
	

	 
	
	



	Question 10:


(1 Point) 
	Which file type retains only text when used to transfer documents between applications or platforms?


a. Plain Text Format 
b. Rich Text Format 
c. Adobe Acrobat Reader 
d. WinZip 
	

	 
	
	



	Question 11:


(1 Point) 
	What video file format stores synchronized multimedia data?


a. Advanced Streaming Format 
b. Picture Expert Group 
c. Windows Media Video 
d. Audio Video Interleave 
	

	 
	
	



	Question 12:


(1 Point) 
	An Outline View is:


a. It provides a good overview of the presentation. 
b. Text can be copied or rearrange from one slide to the next. 
c. The sequence of individual bullets that can be moved within or to another slide. 
d. All of the above. 
	

	 
	
	



	Question 13:


(1 Point) 
	What is a flowchart?


a. An object that enables the user to place it anywhere on a slide 
b. A line that is attached and moves with shapes. 
c. An illustration showing the sequence of a project or plan. 
d. None of the above. 
	

	 
	
	



	Question 14:


(1 Point) 
	What is a shape that includes a line with a text box that can be used to add notes?


a. Line 
b. Callout 
c. Connector 
d. Flowchart 
	

	 
	
	



	Question 15:


(1 Point) 
	Which of the following is/are view(s) in PowerPoint?


a. Normal View 
b. Slider View 
c. Sorter View 
d. All of the above. 
	

	 
	
	



	Question 16:


(1 Point) 
	What is an extension of a movie file?


a. .wmv 
b. .mpeg 
c. .pptx 
d. .docx 
	

	 
	
	



	Question 17:


(1 Point) 
	A gradient fill is known as a/an:


a. Image from file into a shape. 
b. Solid fill, one without transparency. 
c. Blend of colours and shades. 
d. Texture such as marble into a shape. 
	

	 
	
	



	Question 18:


(1 Point) 
	Which of the following statement is true when flipping an object?


a. It can be rotated. 
b. It can be flipped vertical. 
c. It can be angled at 90° 
d. None of the above. 
	

	 
	
	



	Question 19:


(1 Point) 
	Which of the following is a SmartArt Diagram catergory?


a. List 
b. Cloud 
c. Bullets 
d. Telegram 
	

	 
	
	



	Question 20:


(1 Point) 
	What can be printed in PowerPoint?


a. Slides 
b. Handouts 
c. Note Pages 
d. All of the above. 
	

	 
	
	



	Question 21:


(1 Point) 
	The Quick Style gallery has the following format(s):


a. Edges 
b. Shadows 
c. Line Styles 
d. All of the above. 
	

	 
	
	



	Question 22:


(1 Point) 
	Which category are these backgrounds - Checks, Stripes, Blocks or Dots - found in:


a. Subtle 
b. Footer 
c. Intense 
d. All of the above. 
	

	 
	
	



	Question 23:


(1 Point) 
	Movement applied to individual elements on a single slide is known as:


a. Animation 
b. Animation Scheme 
c. Custom Animation 
d. Transition 
	

	 
	
	



	Question 24:


(1 Point) 
	What is the default view in PowerPoint?

a. Normal View 
b. Slide Pane 
c. Contextual Tab 
d. Gallery 
	

	 
	
	



	Question 25:


(1 Point) 
	What file incorporates a theme a layout and content that can be modified?


a. Rich Plain Text 
b. Template 
c. Word 
d. All of the above. 
	

	 
	
	



	Question 26:


(1 Point) 
	Why is it a good idea to add sound to a presentation?


a. To spice up a presentation. 
b. To give a headache to the audience. 
c. To confuse the audience. 
d. None of the above. 
	

	 
	
	



	Question 27:


(1 Point) 
	What does an adjustment handle look like on a shape?


a. Black Plus 
b. Yellow Diamond 
c. Red Star 
d. Blue Circle 
	

	 
	
	



	Question 28:


(1 Point) 
	What is the extension of Tagged Image File Format?


a. .tiffany 
b. .wmf 
c. .tiff 
d. .rom 
	

	 
	
	



	Question 29:


(1 Point) 
	What is a vector graphic?


a. It is rotation handle. 
b. It is way to crop images. 
c. It is a sizing handle. 
d. None of the above. 
	

	 
	
	



	Question 30:


(1 Point) 
	How many levels of indentation in PowerPoint 2007 does it accommodate?

a. 2 
b. 5 
c. 9 
d. 12 
	

	 
	
	




	True and False
	Question 1:


(1 Points) 
	A textbox is an object that enables a user to place text anywhere on a slide.




· True 
· False 
	



	Question 2:


(1 Points) 
	Background Styles Gallery can be found in the Home Tab.




· True 
· False 
	



	Question 3:


(1 Points) 
	A Table and Clip Art are objects that can be entered in the presentation.




· True 
· False 
	



	Question 4:


(1 Points) 
	Slide Sorter View displays a full screen view of a presentation.




· True 
· False 
	



	Question 5:


(1 Points) 
	The layout of SmartArt Diagram can be modified.




· True 
· False 
	



	Question 6:


(1 Points) 
	Shapes cannot be filled using the Picture Fill option.




· True 
· False 
	



	Question 7:


(1 Points) 
	A Pyramid SmartArt Diagram is used to show steps in a process or a timeline.




· True 
· False 
	



	Question 8:


(1 Points) 
	The Shape Effects can be found in the Shape Styles group on the Format Tab.




· True 
· False 
	



	Question 9:


(1 Points) 
	The most common used Slide Layout is Title and Content Layout.



· True 
· False 
	



	Question 10:


(1 Points) 
	A connector is the point where a curve ends or point where two ends meet.




· True 
· False 







